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Chapter 1

Working with the New Interface

To say that the new Internet Information Services (IIS) 7 interface is different from the IIS 6 interface is
akin to saying that a plane is different from a boat. Anyone who looks at the new IIS will instantly see
that Microsoft has made significant changes. Some people may be mystified as to why anyone would
call the new product IIS, because it doesn’t look anything like the previous version of the product.

Microsoft has specific goals for IIS 7 that will help developers and administrators alike to work
together. In addition, they’ve added features to make IIS more reliable and to help it perform better.
All of these changes (and many more) define an IIS that looks nothing like its predecessor and,
for once, almost all of the changes are for the best. After you read this chapter, you’'ll agree that
Microsoft has made some good decisions this time around.

Of course, the fact that the changes are good doesn’t mean you'll like all of them. Some of them
will affect your applications and will mean doing a little rework. All of the changes will definitely
affect any scripts you have for working with IIS and you'll generally find yourself starting again
at the basics. You'll find yourself asking why Microsoft didn’t produce this IIS in the first place
because it really is so much better.

In this chapter, you will learn how to do the following;:

# Define a new way to manage IIS

@ Apply the drill-down approach to management

€ Understand the features view versus the contents view
@ Sort features and contents in a specific order
L 4

Perform specific actions with objects

Defining Microsoft’s New Approach to 1IS Management

One of the problems with the older versions of IIS is that Microsoft didn’t encourage the parties
responsible for maintaining a Web site to work together. The new IIS fixes that problem by placing
a focus on the application and on the tasks administrators and developers must perform together.
In addition, IIS 7 places a major emphasis on ASP.NET. Instead of being a mere add-on, ASP.NET
is now a major part of IIS, which means that your ASP.NET applications will run better and with
fewer errors. No longer will you need to rely on command line utilities such as ASPNet_RegIIS.EXE
to fix registration problems with your IIS setup. The following sections provide an overview of
Microsoft’s new approach. Chapter 2 provides a detailed view of individual IIS features.

This book assumes that you've already installed IIS 7. You'll find the IIS setup features in the
Windows Features dialog box shown in Figure 1.1. To access this dialog box, click the Turn Win-
dows Features On or Off link in the Control Panel\Programs and Features folder. Installing
some features automatically installs other features as needed by IIS. For example, if you install File

%




%% é 78935.book Page 4 Wednesday, August 15,2007 11:26 AM

4 | CHAPTER 1 WORKING WITH THE NEW INTERFACE

Transfer Protocol (FTP) support, IIS also installs some of the IIS 6 Management Compatibility
features because you manage FTP using the Internet Information Services (IIS) 6.0 Manager (see

Chapter 7 for details).
FIGURE 1.1 - —
Install the IS features CY Windows Features EI
Turn Windows features on or off [7]
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TIP 1 strongly suggest that you install the full 1IS 7 suite when working with this book. You can
always remove features you don’t want to use later. If you really want to see what 11S 7 can do, you
need to install everything and test it out. Never use a production machine for an initial installation.

Administrators and Developers Work Together

In the past, you needed several different tools, along with command line utilities, to manage IIS
completely. With IIS 7, you use a single tool to perform all of your work. As shown in Figure 1.1,
this one tool helps you manage Web sites and all of the ASP.NET functionality in one location. You
can sort the icons in a number of ways (feature name and description), group them (category and
area), and show them in a number of forms (details, icons, tiles, and list). Figure 1.2 shows the
default setup, which relies on a feature name sort, area group, and icon display.

TIP Older versions of 1IS placed restrictions on a client setup—in part, to force you to buy a
server for some needs. 11S 7 lets you create as many Web sites as needed and it no longer has the
10-connection limit. These changes mean that you can perform real-world application testing
and use a client setup in ways that may have required a server in the past.

The changes to IIS also affect Web site hosting. You can use the delegated administration feature
to let a customer administer their Web site. The customer can only see their Web site and not any
of the other Web sites on the server. To go along with this new setup, IIS 7 uses HTTP-based Web
services for the administration tool, rather than the Distributed Component Object Model (DCOM)
connectivity used in the past. The difference in communication technique means that someone can
administer IIS through a firewall—firewalls often blocked the DCOM connection.

Of course, this new connectivity also makes it possible for a developer to make tweaks needed
to an application from a remote location, rather than making them on site. A developer can fix any
application errors faster because it’s easier to get to them quickly.
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FIGURE 1.2
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An Emphasis on ASP.NET

You'll find that ASP.NET appears everywhere in IIS 7. Some of the changes aren’t immediately obvi-
ous by looking at Figure 1.1. IIS 7 doesn’t rely on a single metabase configuration store any longer.
Instead, it uses the same Web . CONFIG file setup that ASP.NET uses to store configuration settings.
This change means that you can copy the settings for a Web site from the test server to the production
server without having to rely on scripts or other messy solutions. You can also copy settings from
your system to a client system as needed to support applications as a third-party resource.

The Internet Information Services (IIS) Manager has more than just a new look. Microsoft wrote
this administration tool using .NET technology. What you're seeing in Figure 1.1 is Windows form
technology. You can use this feature to extend the administration tool. For example, you could write
your own HyperText Transport Protocol (HTTP) runtime modules and configuration settings.

Security is a significant problem on any Web site. In the past, there was a difference between IIS
and ASP.NET when it came to security. You always had to write workarounds and kludges to use
NET security within your applications. IIS 7 places the NET role-based security at the forefront. For
example, when you open the .NET Roles icon, you can set the roles for NET applications executing
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on the server. No longer do you need to go through some odd configuration procedure before the
security on your application works.

NOTE Youmusthaveacopy of SQL Serverinstalled on your system to employ many of the 11S security
features. For example, even though you can select the AspNetWindowsTokenRoleProvider as a
provider, this choice limits you to the roles defined as part of Windows security, which means you
can’t configure customroles. In short, if you want to obtain the full benefits of 11S 7, you must have SQL
Server installed. Fortunately, you can use SQL Server Express, a free product, for a local setup. See
“Obtaining and Installing SQL Server Express” for more details.

Obtaining and Installing SQL Server Express

You can use SQL Server Express to implement the advanced IIS 7 features on a client machine if you
only need a limited number of connections or you're performing development tasks. SQL Server
Express doesn’t provide the robust interface that the full version of SQL Server does, but if you obtain
SQL Server Express from http://msdn.microsoft.com/vstudio/express/sql/register/
default.aspx, you should have everything you need.

NOTE You’ll actually see two versions of SQL Server Express on the Web site. The only time you
need to obtain SQL Server 2005 Express Edition with Advanced Services SP2 or Microsoft SQL
Server 2005 Express Edition Toolkit is when you need the functionality these two products pro-
vide, such as reporting services. Developers also need the advanced version to obtain full func-
tionality with Visual Studio. Even though you don’t need them to use 11S, you’ll likely want to
download the SQL Server 2005 Books Online so that you can obtain answers you have about con-
figuration and SQL Server errors when they occur.

After you download a copy of SQL Server Express, either version, you'll need to install it. The
following steps help you set up your hard drive and perform the required installation. You can skip
this section if you haven’t compressed your hard drive. SQL Server requires an uncompressed
folder for installation, so you need to create one manually or the setup program complains.

1. Create a folder for SQL Server. Right-click the new folder and choose Properties from the
context menu. You'll see a folder Properties dialog box.

TIP 1f you have two hard drives on your system, install IIS on one of them and SQL Server on the
other to gain better performance. If you have three hard drives, install the SQL Server log files on
the third drive to obtain even better performance. Using a three-drive setup provides optimal
performance for an 11S configuration. Three partitions on a single drive aren’t the same as three
physical drives. The goal is to use different hardware for each activity so the system doesn’t spend
as much time waiting for actions to complete.

2. Click Advanced. You'll see the Advanced Attributes dialog box shown in Figure 1.3.

3. Clear the Compress Contents to Save Disk Space option and click OK twice. The folder is
now ready for use by SQL Server.

Now that your hard drive is prepared, you can begin the SQL Server installation. The following
steps tell how to perform this task.

1. Double-click the icon for the version of SQL Server that you downloaded. You'll see the End
User License Agreement dialog box.

- @
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FIGURE 1.3 -
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2. Read and accept the licensing terms. Click Next. You'll see an Installing Prerequisites dialog
box if you haven't installed SQL Server on the system in the past.

3. Click Install. SQL Server installs the Microsoft SQL Native Client and the Microsoft SQL
Server 2005 Setup Support Files.

NOTE Ifyou choose to remove SQL Server from your system, you need to uninstall the prerequi-
site features separately. Make sure you uninstall the SQL Native Client as the next-to-last feature
and the Microsoft SQL Server 2005 Setup Support Files as the last feature or you’ll experience
problems uninstalling SQL Server and its support features.

4. Click Next. You'll see the Welcome dialog box.

5. Click Next. SQL Server performs a system configuration check. When this check is complete,
you'll see a System Configuration Check dialog box like the one shown in Figure 1.4. All of
the checks should have success indicators. If you see a warning, check the message and try
to fix the problem before you proceed. If you see an error, you must fix the problem before
you proceed or SQL Server Express won't work well. In most cases, if your system runs Vista
well, it will also run SQL Server Express well.

NOTE The help files provided with SQL Server Express work well with Windows XP or Windows
2000 but not with Vista. For example, the instructions tell you to open the Add/Remove Pro-
grams applet, even though this applet appears as Programs and Features in Vista. You’ll need to
perform some conversions for the help instructions until Microsoft fixes this problem.

6. Click Next. SQL Server performs a few installation steps and then asks you to enter your
name and company name.

NOTE Clear the Hide Advanced Configuration Options dialog box if you want to configure all of
the advanced SQL Server features, such as how it performs sorting. In most cases, you won’t need
to configure these options when installing SQL Server Express for 11S.

7. Type your name as a minimum and then click Next. You'll see a Feature Selection dialog box
similar to the one shown in Figure 1.5. (Figure 1.5 shows the advanced version—the stan-
dard version contains fewer features.)
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FIGURE 1.4
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8. Choose the features you want to use. As a minimum, choose the Management Studio
Express entry so that you can manage your SQL Server Express installation. Developers
should choose all of the Client Components group entries. The only time you need Report-
ing Services is if you plan to report on IIS database entries (security and advanced features).
Normally, you won’t need this feature on a local machine. If you've set up special folders for
your SQL Server installation, perform these additional steps as well.

A. Highlight the Database Service entry and click Browse. Choose the folder you have set
up for the SQL Server database files.

B. Highlight the Shared Tools entry and click Browser. Choose the folder you have set up

for the shared tools files.

9. Click Next. You'll see an Authentication Mode dialog box. For security reasons, you always
want to choose Windows Authentication Mode unless you have existing code that requires

Mixed Mode.
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Choose an authentication mode and click Next. You'll see a Configuration Options
dialog box.

Check the Add User to the SQL Server Administrator Role option to ensure you can manage
SQL Server Express. Click Next. At this point, you can see one of two dialog boxes, depending
on the options you selected: Report Server Installation Options or Error and Report Usage
Settings. If you see the Error and Report Usage Settings dialog box, skip to step 13.

If you selected the Report Server option, SQL Server asks if you want to use the default con-
figuration. Normally, you'll want to use the default configuration, so click Next to get past
this dialog box. If you want to see the default settings, click Details instead and follow the
prompts. At this point, you'll see the Error and Report Usage Settings dialog box.

Choose the error and report usage settings that you want to use and then click Next. You'll
see a Ready to Install dialog box.

Click Install. SQL Server performs the required installation. When the installation completes,
you should see a success dialog box like the one shown in Figure 1.6.

"L Microsoft $GL Server 2005 Setup =

The sefectad componants are being configured

(G501 Native Cient Sebup fiizhed
(501 VS5 Writer Sebup fiished
(ZHS0L Server Database Services Setup frushed
& 1 Setup finshed
i
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(@ Beportng Serioes Setup finshed
(/201 server Manoement Studo Express  Zaup finshed
& il npgrents, Books Onln.., Setup finished

Heip | hextwx | sl |

Verify that all of the SQL Server Express elements installed correctly. If a feature didn’t
install correctly, click the Setup Finished link for that feature to see the log entries. In most
cases, you'll need to fix any installation errors as a separate action before you can use SQL
Server Express.

Click Next. You'll see a Completing Microsoft SQL Server 2005 Setup dialog box.
Click Finish.

SQL Server Express is installed but not ready for use yet.

. Open Start > Programs > Microsoft SQL Server 2005 > Configuration Tools > SQL Server

Configuration Manager. You'll see the SQL Server Configuration Manager console.

Openthe SQL Server Configuration Manager\SQL Server 2005 Network Configuration\
Protocols for SQLEXPRESS folder shown in Figure 1.7.

Right-click the TCP/IP entry and choose Enabled from the context menu. You'll see a Warn-
ing dialog box. Click OK to accept it.

%
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FIGURE 1.7 - e
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5. Right-click the SQL Server (SQLEXPRESS) entry and choose Restart from the context menu.
Windows restarts the database engine service for you.

6. Right-click any other services that start automatically and choose Restart from the context
menu. Windows restarts the service for you.

7. Ifyou plan to use SQL Server Express for development, you need to activate the SQL Server
Browser so Visual Studio can locate your server. Follow these configuration steps to activate

the

service.

Double-click the SQL Server Browser entry. You'll see a SQL Server Browser Properties
dialog box.

Select the Service tab.

Choose Automatic in the Start Mode field.

Click Apply. SQL Server sets the service to start automatically.
Select the Log On tab.

Click Start. SQL Server starts the SQL Server Browser service.
Click OK.

8. Close the SQL Server Configuration Manager. The SQL Server Express setup is now ready
for use with IIS.

%
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Using the Drill-Down Approach

Previous versions of IIS used an interface that relied heavily on Properties dialog boxes. The tabs
on these Properties dialog boxes could vary a great deal depending on the features you installed.
For example, adding FrontPage Extensions to your setup added another tab to some, but not all,
dialog boxes. ASP.NET also added tabs in some cases. The problem is that it was possible to become
quite confused as to where to find something because you never really saw an overview of any-
thing. Everything was in its own little tab pocket. IIS7 uses a drill-down approach to overcome this
problem. You begin with an overview and then drill down to the functionality you actually require.
Atno time do you have to worry about becoming overwhelmed with details that you don’t actually
need. The following sections describe this drill-down approach in more detail.

As shown in Figure 1.2, IIS 7 uses an Explorer-like display. Choosing an entry in the Connections
(left) pane defines icons you see in the Features (middle) pane and the actions available in the Actions
(right) pane. Consequently, when you choose a Web site, the icons change, as shown in Figure 1.9.
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NOTE The name of the middle pane can vary according to activity. Youw’ll find several activity-
based names for it in this chapter alone.
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1IS provides specific functionality at different levels. For example, when you set the NET Com-
pilation values for the entire site, they become the default values for all Web sites you create. How-
ever, you can set these same values for an individual Web site and it affects everything on that Web
site. It's possible to go down another level and change the .NET Compilation setting for a folder or
an application. In this case, the settings affect only that folder or application. Table 1.1 describes the
various icons and the levels where you can use them.

TABLE 1.1: Icon Summary for I1S 7

ENTIRE INDIVIDUAL

ICON NAME SITE 'WEB SITE FOLDER APPLICATION DESCRIPTION

.NET Compilation X X X X Defines the settings
for compiling a .NET
application.

.NET Globalization X X X X Determines how IIS handles

globalization issues for .NET
applications. You also use
these settings to determine
the encoding used for text.

.NET Profile X X X Configures the per user
settings. This configuration
information affects
everything fromthefeatures
the user can access to
how the Web site behaves.

.NET Roles X X Defines groups of users
by the roles that they fill
withinan organization. For
example, you might have
roles for administrators,
developers, managers, and
standard users.

.NET Trust Levels X X X X Defines the trust level for
management modules.
This feature is part of code-
based security. You use it
to restrict the actions that
code can perform.

.NET Users X X Defines a list of users for
access purposes. You canuse
this list for authorization
and as a means of
determining user access
to site features.

. 4 1|0
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TABLE 1.1:

ICON NAME

Application Settings

ASP

Authentication

Authorization Rules

CGI

Connection Strings

ENTIRE
SITE

X

INDIVIDUAL
'WEB SITE

X

Icon Summary for IIS 7 (CONTINUED)

FOLDER

X

APPLICATION

X

DESCRIPTION

Lets you create custom
settings for your
applications. You can use
these settings to control
application behavior.

Definesthe settingsused to
host Active Server Pages
(ASP)applications. You can
control everything from
the default scripting
language to the use

of COM+.

Determines which forms
of authentication that 11S
accepts. The default
setting provides
anonymous access. You
can also choose to enable
ASP.NET, basic, digest,
forms, and Windows
authentication.

Provides rules for allowing
access toa Web site or Web
site element (such as an
application). The default
setting allows all users
access to the Web site as
awhole.

Defines basic rules for
working with Common
Gateway Interface (CGI)
applications.

Provides connections to
database managers.

13
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TABLE 1.1: Icon Summary for 1IS 7 (CONTINUED)

ENTIRE INDIVIDUAL
ICON NAME SITE 'WEB SITE FOLDER APPLICATION DESCRIPTION

Default Document X X X X Sets the default document—
the one that the user sees
when typing just the
Uniform Resource Locator
(URL) without a document
name. The default settings
include Default.htm,
Default.asp,index.htm,
index.html,iisstart
.htm,and default.aspx
as the default documents.

Directory Browsing X X X X Determines what data
the user sees when using
directory browsing. 11S
disables directory
browsing by default.

Error Pages X X X X Defines the pages that I1S
uses to handle specific
HTTP error responses.

Failed Request X X X X Creates a set of rules for

Tracing Rules tracing failed requests. 1IS
doesn’t provide any default
failed request tracing. The
trace can affect a specific
technology, such as
ASP.NET, and a specific
HTTP error. You can also
set the level of output
information.

Feature Delegation X Helps you control the
delegation state of 11S
features. For example, you
might want someone to
know the CGlI settings for
the server, but not be able
to change them when they
only have access to a single
Web site.

Handler Mappings X X X X Tells 11S how to handle
specific file types.

+/@
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TABLE 1.1: Icon Summary for IIS 7 (CONTINUED)

ENTIRE INDIVIDUAL

ICON NAME SITE 'WEB SITE FOLDER APPLICATION DESCRIPTION
ISAPI and CGI X Determines how 11S
Restrictions handles Internet Server

Application Programming
Interface (ISAPI) and CGl
modules. 11S provides
default ASP and ASP.NET
ISAPI modules. It doesn’t
provide any default CGI
modules.

ISAPI Filters X X Provides a means of
configuring ISAPI filters
onlIS.

MIME Types X X X X Defines the Multipurpose
Internet Mail Extensions
(MIME) types for certain
file extensions. The MIME
type determines how an
email program handles the
file and which helpers it
uses to interact with
the file.

Modules X X X X Configures and
administers managed
code modules used with
11S to provide services.

Pages and Controls X X X X Defines application level
settings for pages and
controls, such as the
namespaces that they rely
on for support code.

Providers X X X X Determines which security
features that 11S uses in
managing user access. The
providers affect users,
roles, and profiles.
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TABLE 1.1: Icon Summary for IIS 7 (CONTINUED)

ENTIRE INDIVIDUAL
ICON NAME SITE 'WEB SITE FOLDER APPLICATION DESCRIPTION

Server Certificates X Provides a means of adding
certificates to the server.
You can install third-party
certificates or create a self-
signed certificate for local
(personal) use.

Session State X X X X Controls how 1IS manages
the client session data.
These settings include
timeout values and the use
of cookies.

SMTP Email X X X X Determines the Simple
Mail Transfer Protocol
(SMTP) settings that 11S
uses when sending email
from an application.

SSL Settings X X X Determines the Secure
Sockets Layer (SSL)
settings. You use SSL
to encrypt documents.
11S supports 128-bit
encryption. It’s also
possible for require a client
certificate for mutual
authentication.

Worker Processes X Displays the state of
worker processes running
on the server.

Using Features View versus Contents View

The fact that you see a hierarchical Explorer-like display in the new IIS naturally prompts the ques-
tion of how you can see the content of each of the entities. The answer lies in the tabs at the bottom
of Figure 1.2. Whenever you select an entry in the Connections pane, the contents of the middle
pane vary. Up to this point in the chapter, you’ve seen the Features pane, which contains all of the
icons that help you configure IIS. Click the Contents tab at the bottom of the screen and you'll see
the Contents pane, as shown in Figure 1.10.

As with the Features pane, the Contents pane reflects the element you select in the Connections
pane. The Actions pane reflects the major tasks you can perform with the selected element in the
Contents pane. You can also right-click the element to choose actions from the context menu.

- @
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FIGURE 1.10
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TIP NoticeinFigure1.10 that one of the actions is Convert to Application. Microsoft made this fea-
ture more accessible in 11S 7 so that you can easily set up a folder as an application. Whenever you
move an application from one machine to another, there’s a chance that the new machine will see
an application as a folder. This feature makes it very easy to configure the folder as an application
so that 11S will work with it correctly. You must configure ASP.NET folders as applications before
11S will use them to serve the desired content.

Displaying Features and Content in Order

Figure 1.2 shows the Features pane in the default configuration, while Figure 1.10 shows the default
setup for the Contents pane. In most cases, these views will work fine, but they may not always
meet your needs. For example, you might want to group features in a particular way or you might
want to see a detailed view of them. Features let you display the content based on:

¢ Group (Area and Category)
¢ Sort (Feature Name and Description)
& View (Details, Icons, Tiles, and List)

Figure 1.11 shows the Features pane using the Category grouping, sorted by Description,
and with a Details view. As you can see, the display is significantly smaller than the one shown
in Figure 1.2 and provides more information, but the icons are harder to see, so you might actu-
ally spend more time looking for what you need. You can select the grouping using the Group
By field, the view by choosing an option from the View split button, and a sort by choosing a
column in the Details view. If you aren’t using the Details view, choose an option from the
View > Sort By menu instead.

- @
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FIGURE 1.11 s
. 5 Internet Information Services (I15) Manager =
Choose a display that .
@ o [@ v mansta » webstes » secondaryste » | Gl -
helps you work faster
. . File View Help
and more efficiently -
. | Connections. | n R Actions.
inIIS. - @ Secondary Site Home
| Open Feature
4 85 MAINVISTA [MAINVIS i T
. = ool | GTouR by | Category [-|E- Manage Web Site
§ FTP Sites Feature Name Description - & Restart
4[] Web Sites o P Start
@ Detautt web Application Development o sop
4 & Secondary i | ASMIPEmail Cenfigure e:mail address and delivery optil
- 7] App_Dats & NET Globalization Configure globalization properties for mai Ji Explare -
- myapplic | [Elapplication settings Configure name and valug pairs for manag Browse Web Site
[ MET prafile Configure options that track use Bl Browse
1| ase Configure properties for ASP applications B o
Eca Configure properties for CGl programs ¥
{‘-3 JMET Compilation Contigure praperties for compiling manag Bincing: S
[ Pages and cantrals Configure properties for pages and contre| [E Basic settings...
2, Praviders Configure praviders for provider-based apl— Advanced Settings...
ﬂ)Scsswn State Configure session state settings and Form View Applications
[=¥| Connecticn Strings Configure strings that Web sites and appli Viewe Virtusl Direclones
Heazlth and Dizgnostics
Configure
i Falled Request Tracin...  Configure logging of falled request traces Falied Bequent gl
HTTP Features
Limits..
| @ Detault Document Configure default files to return when clie =
EIMIME Types Configure extensions and assaciated cont — L
| i v
‘ m ] b E Features View (|75 Content View
Ready L

When working in the Contents view, you can choose not to use a grouping at all or group the
content by type. In addition, you can choose some level of filtering or no filtering at all. When you
filter content, you can choose to filter it by:

¢ Name
¢ Type

When you filter by name, the filter applies to the entire entity name. For example, if you type App,
then everything with the word App in it appears in the Contents pane, as shown in Figure 1.12. If you
want to remove the filtering, click Show All. You can change the kind of filtering that IIS uses by click-
ing the down arrow next to Go and choosing a different option from the list. All of the grouping and
filtering options also appear on the View menu. This figure also shows the effects of grouping the

display by type.

Working with the Actions Pane

The Actions pane shows the most common activities that you can perform with a particular selection.
If you select an entry in the Connections pane, the Actions pane will reflect the tasks you can perform
with that entry. However, the moment you select an entry in either the Features or Contents pane, the
Actions pane entries reflect the activities you can perform with that entry. Consequently, it's possible
to see different Actions pane views even when the other panes haven’t changed. The Actions pane
always reflects the tasks you can perform with the highlighted element.

The Actions pane may not show advanced tasks. Consequently, if you want to see everything
you can do with a particular entry, right-click the entry and choose an option from the context
menu. That said, the Actions pane contains most of the tasks you'll perform and you may never
need to rely on the context menu.

+/@
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Don’t confuse the Actions pane with a properties pane. The Actions pane never displays settings
changes you can make to a feature. When you need to make a settings change, always double-click
the icon for the feature to view its settings. For example, Figure 1.13 shows the settings for the Pages
and Controls feature. The Actions pane will always include only the activities you can perform
with a given feature or content.
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Understanding Friendly Names and Configuration Names

IIS 7 uses a Web . CONFIG file to hold the settings you provide. So you can modify the Web . CONFIG
file by hand or using a custom application—you don’t even need to use the Internet Information
Services (IIS) Manager to perform most configuration tasks. Of course, it helps to know what the
settings are so that you have a better idea of how to modify them. IIS helps you discover the entry
names. Figure 1.13 shows the friendly name of the entries for the Pages and Controls feature.
However, if you select Configuration Names from the Display field, the names change, as shown
in Figure 1.14.

Some of the names are quite similar. For example, Buffer in Figure 1.13 appears as buffer in Fig-
ure 1.14. Other names are different. For example, Enable Authenticated View State in Figure 1.13
appears as enableViewState in Figure 1.14. Let’s say you make a change to the enabTeViewState
option and then click Apply in the Actions pane. The change will appear in the Web . CONFIG file for
the entry, as shown in Figure 1.15.

The enabTeViewState option appears as an attribute of the <pages> element. You could just as
easily make the change directly to the Web . CONFIG file, as shown here. Of course, it’s much easier

using the Internet Information Services (IIS) Manager to make the change.
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Let’s Start Building

This book is about building—building Web sites, building applications, building a good user
experience, and building a secure environment. Most of all, it’s about building a team. Instead of
using separate tools to perform tasks separately, all of the members of the Web site team now
work together using a single tool. Although IIS 7 involves a lot of change, it also provides many
new features that help you create and manage Web sites with greater ease. This chapter helps you
build these skills:

Define how administrators and developers work together
Understand the use of ASP.NET in IIS 7

Use the user interface to locate features

Modify the basic IIS 7 setup

Define the difference between features and content
Order the information on screen

Perform common actions

® 6 6 6 o o o

Define the difference between friendly and configuration names

Now that you have these new skills, it’s time to put them into action. IIS 7 uses a drill-down
approach that requires you click things to explore. Consequently, one of the tasks you should per-
form first is to open a copy of Internet Information Services (IIS) Manager and start clicking icons
to see how things work. Because the interface is so different, you’ll want to spend some time explor-
ing it before you do any real work with it.

In addition to exploring the interface, take the time now to install a copy of SQL Server if you
want to use some of the advanced features that IIS 7 provides. Remember that you don’t need to
purchase a copy of the full SQL Server product; all you really need is the free version of SQL Server
Express to get the job done. Download and install the product as mentioned in the “Obtaining and
Installing SQL Server Express” section of the chapter.

Chapter 2 provides details about using the new interface. Make note of the features you don’t under-
stand as you click around the user interface. You'll find information about using them in Chapter 2. In
addition to more information about the new interface, Chapter 2 shows how to perform some addi-
tional management tasks. Many of these tasks are generic—you’ll perform them with most of the appli-
cations you create, no matter what kind of application it is. For application-specific tasks, make sure you
review Part 2 for older applications and Part 3 for ASP.NET applications.
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